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__ CHECK YOUR IT IQ-

Before you begin this chapter, see what you already know
about information technology by scanning the QR code to
take the chapter pretest. If you do not have a smartphone,
visit www.g-wlearning.com.

Good file management means that the user
knows how to organize information on a computer.
Not only do files need to be named in a meaningful
way, the user must be able to locate files when
necessary. A sign of poor file management is file
names that do not indicate what the file contains.
Not keeping track of where files are saved is also a
sign of poor file management.

Files can be lost for many reasons: accidental
deletion, unintentional overwriting with another
file, theft, misplaced removable media, hard
disk failure, or loss of the computer. Part of good
file management is keeping multiple copies of a
file in case of a loss. Good file management also
implies that the user has created a safe location
for saving the files. In a networked environment,
many opportunities are present for other users to
accidentally or intentionally cause file losses.
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FILE AND FOLDER NAMES

A computer file is a collection of 1s
and Os that has meaning. This collection
resides in computer memory or in a
storage location. Software programs
may create temporary files that are
deleted when the software program no

longer needs them. Other files contain
information created by a user, and the
software allows the user to save and
open the file for further use. When a file
is saved, it is given a file name so that
the file can be located and used again. It is a good practice

to assign meaningful and memorable file names so you or
another person can recognize the files.

Windows uses a system of named folders to catalog
and contain files. Notice that the names in Windows echo
activities in an office or school setting. When students save
paper files that belong together, they often use a manila
folder. A Windows folder performs the same function for
electronic files. Folders allow similar files or all files for a
project to be organized together. This section discusses the
naming of files and folders.

How is a file-naming
scheme important to
good computing?

Chapter 4 File Management

Windows File and Folder Names

The file name is a label that identifies a unique file on a computer
system. There are three parts to a file name in the Windows operating
system

e the file name

e a period (or “dot”)

¢ the file name extension
For example, consider abcde.ext as the file name. In this example, abcde is
the file name and ext is the file name extension. The period separates the file
name and the file name extension. Notice that Windows uses the term file
name for both the whole name and the part of the name before the period.

A folder is a container in which files are stored. A subfolder is a
folder contained within another folder. A subfolder is said to be nested
within the parent folder. There may be several levels of nesting, as a
subfolder may itself contain a subfolder that in turn contains another

The terms folder and
directory are used
interchangeably. They
mean the same thing.

subfolder, as shown in Figure 4-1. A folder name is a label that identifies a
unique folder on a computer system. In the Windows operating system, a
folder name consists of only a name. There is no extension, so there is no
period, either.

Legal Names

File names in Windows are limited by the number of characters
in the folders and subfolders that hold the file. For example,
C:\Program Files\abcde.ext indicates a file named abcde.ext that is located in
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Figure 4-1. A folder may contain many subfolders, each of which may contain additional subfolders.
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the Program Files folder on the C: drive. This string is called the file path,

which is the drive and folder location of a file plus its file name. The total Bymbe BEserption
number of characters in the file path cannot exceed 260 characters. Notice (x Less than symbol or left chevron
that the path includes the colon (:) for the drive letter and backslashes (\) > Greater than symbol or right chevron
to indicate where there is a change in folder. : Colon
The file path can be seen in the Properties dialog box. Right-click on « Double quote
Sustainability Training a file, and click Properties in the shortcut menu. The file name is listed at
Green companies lead by the top of the General tab, and the path to the folder containing the file is : Favard sich
example and educate their shown in the Location: area, as shown in Figure 4-2. The full file path is \ Backslash
Eg?;%ize;rggtiisst?mabie the locati(.)n Plus the file name. . [ Vertical bar or pipe
Through sustainability The limit of 260 characters provides ample space for writing a ? Question mark
training, employees learn clear and unique name for each file and folder. Any character from the i Astarialk
the importance of going keyboard may be used in a name except for a few reserved symbols.
green at work and the Reserved symbols are characters that Windows uses for special meaning. ScuRbaR e SbiEr
best practices to reduce The reserved symbols are shown in Figure 4-3, Figure 4-3. Reserved symbols cannot be used in file or folder names.

waste and lower energy

Apply

l ; s Although Windows allows spaces in names, spaces caus bl
consumption. Trainin . s SP & PEOSEnTS 5 ;
empl oyepes in simple 9 in other software environments. Some software will stop reading the AH files and fold'ers should have unique nam(?s. Alt.hough i
green procedures can name at the first space. A URL or web address that contains a space will § = Eling spstems ‘_NIH .a]low POk BeaTaR 1.11any ﬁ.les. with the sanre Ll
| not only help save the be misinterpreted. For example: as Iongl asktheyfare in d1ffEreEf folciiers or drllves, this ;ls not a golcid ldfﬁ
' en looking for a specific file and several appear, the user will not know
environment, but save the http://www.pages.com/my document.doc Wh e P ppeat
company money, t0o. ) which one is correct.
will be read as:
http://www.pages.com/my Meaningful Names
: For this reason, it is best to not use spaces in file and folder names. The file name should clearly describe what is in the file. For example,
suppose a student uses labReport to name a biology project. This may
File name be satisfactory if there is only one lab report. However, if another lab
J : / report is created later, it would not be clear which file is for which report.
‘ _,, _W‘?_”fs.7ée Properties Instead, more descriptive file names such as
General | Securty | Detals! /| g LabReportBio and LabReportDNA better describe
w ¥ B the content of the files. A naming convention is a
olkspal.!a | 11 ] . R
- | ‘ ol pattern that is followed whenever a file name is
: || Tupeolfie JPG Fie (jpa) 3 created.
| | Openswitn  Ph ‘ Without spaces between words, long file
i ‘ Locgtich: C:APhotoshop ‘Warking Folder\Adabe Web Gallsryhr names can be hard to lread' _FOI _ex_ample’ the
] /4:'” T —— i name reportforlabexperiment is difficult to read.
File tniaiie / : Sizoon disk: 44,0KE (45,055 bytes) \\ This name would be easy to read if there was an
extension | - “Path indication of the individual words. CamelCase
! Created: Menday, &pril 7, 2014, 2:01:45 P iS a naming COHVEHtiOn ]Il Wh.lCh the begmnmg
Macled:  Hamay Aol T 2013 20145 FM of each word in the name is capitalized. This
ili Al Mol B 2R ' allows the file name to be read easily. For
" || Atbues  [TReadorty [THidden [Advarced., | example, the name reportforlabexperiment becomes
i ReportForLabExperiment in CamelCase. The Goodheart-Willcox Publisher: Teguh MujionofShutlerstock.com
' _ ¥ | CamelCase naming convention got its name due Figure 4-4. CamelCase is using a capital letter for the
k 1 " to the apparent humps the capital letters make in first letter in each word in a file name.
| | ‘ ok ][ Cod | the name, as shown in Figure 4-4.

\
| _ = =
. ) Goodheart-Willcox Publisher
Figure 4-2. The file name, file name extension, and file path are shown in the
Properties dialog box.
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of the file. To change
the format of the file,
it must be saved in a
different format.

Generally, when saving a file, the user adds the file name and
Windows adds the correct file name extension. For example, if the user
saves a document from Microsoft Word, the software saves the file as a
Word document and adds the extension of .docx. It is good practice to let
Windows choose the file name extension. Windows determines the file
name extension based on the software program used to create the file.
When performing a “save as” in many programs, the user can select one
of many different file types in which to save the file. For example, image
editing software, such as Photoshop or GIMP, may have a native file format,
but also allows saving in several other formats, such as TIFF or JPEG.

When a file icon is double-clicked, Windows will locate software to
open the file, launch the software, and load the file. This is made possible
by a feature called file association. File association is a process in which
Windows links a file name extension to a software program. For example,
if a file has an extension of .docx, double-clicking on the file icon causes
Windows to launch Microsoft Word and load the file into Word.

Figure 4-5 shows a few common file name extensions and the
Windows program commonly associated with the file type. In Windows,

Copyright Goodheart-Willcox Co., Inc.
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Extension | File Type Associated Application
avi Video Windows Media Player
C5S Cascading style sheet Default browser
.doc, .docx Document Microsoft Word
.exe Executable-application Windows operating system
.htm, .html Hypertext markup (web page) | Default browser
Jpg, -jpeg Compressed image Default image editor
m Audio-only MPEG4 Windows Media Player
.mp3 Music or sound Windows Media Player
pdf Portable Document Format Adobe Reader
pps Slide show Microsoft PowerPoint
.ppt Presentation Microsoft PowerPoint
rif Rich text format document Default document editor
Swi Flash format Flash Player
Moty usmess Iageslsmmmck.mm Aif, tiff Compressed image file Windows Photo Viewer -
Computer files for schoolwork can be arranged in folders to keep everything orderly. bt = Notepad
wpd Document Corel WordPerfect
- File Name Extensions xls, xlsx Spreadsheet Microsoft Excel
- Flundim%ma's The second part of the file name is the period. Although the first part .Zip Compressed archive Windows Explorer
l of the file name may contain periods as well, the last period on the right is N ———
the one Windows uses to begin the file name extension. Figure 4-5. These are common file name extensions.
The third part of the file name is the file name extension, which
follows the last dot. The file name extension, or file extension, tells the these associations may be changed using the File Associations dialog box.
Changing the file Windows operating system which software to use to open the file. The To access this, open the Control Panel window, click Programs, click Default
nameedtensiot does file name extension indicates the format of the file, but does not control the Programs, and then click Associate a file type or protocol with a program.
not change the format format of the file. The software saving the file controls the format. Do not manually change a file name extension unless there is a

very good reason to do so. Changing the extension removes the file
association. Additionally, some software will not recognize or open a file
using File>Open unless the file has the proper extension.

Naming a Group of Related Files

A project may contain several related files. Using a similar word
pattern in the file names of these files reminds the user that the files
are all related. For example, after completing a science experiment on
determining the boiling points of different liquids, the students have been
asked to record the following.

® hypothesis and methods in a text document

data and charts in a spreadsheet
e experiment setup in a photograph

photograph and results on a web page
® resulfs in a presentation
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If similar files begin
with the same word,
they will be displayed
together in a folder,
which can make it easy
to keep track of the
project files.

A good way to organize similar files is to begin each file name with a
common word. In this example, all documents relate to the boiling lab,
so the word boiling can start each file name followed by the detail of each
document:

® BoilingDescription.doc

¢ BoilingData.xls

® BoilingSetup.jpg

e BoilingResults.htm

® BoilingPresentation.ppt

Another naming convention is to include the creation date in the
file name. The date a file was created or last updated is automatically
recorded and can be displayed in Windows File Explorer. However, in
some cases, adding a date to the file name is more useful because that
will not change each time the file is saved. This is often done to maintain
a date record or to help in sorting files. For example, the file name
160513LabResults.doc refers to the result of a lab test conducted in the year
2016 (16), in the month of May (05), and on the thirteenth day (13). Using
this naming convention allows lab results from many different dates to
be sorted by the year, then the month within a year, and finally by the
day within a month regardless of when the content of the file had been
updated.

Windows File Explorer

Windows File Explorer is a file-management utility with a graphical
user interface that can be used to find anything in the computer’s storage
areas. The Windows File Explorer is part of the Windows operating
system and controls parts of the GUI, including the desktop and the Apps
or Start menu. In Windows 7, the utility is named Windows Explorer. In
Windows 8, the utility is named File Explorer.

The first version of Windows contained MS-DOS Executive as the file
utility. It also served as the graphical user interface instead of the Apps
or Start menu and desktop found in later versions of Windows. MS-DOS
Executive gave way to File Manager in Windows 3.0, at which time the
program no longer served as the GUI and was strictly a file management
utility. Windows File Explorer and the Start menu first appeared in
Windows 95. At this point, the program again became part of the GUL
The Apps menu first appeared in Windows 8.

Windows File Explorer contains the address bar and ribbon or
toolbar at the top of the window, as shown in Figure 4-6. Along the left-
hand side of the window is the navigation pane. This pane contains a list
of the available drives and folders shown in a tree format. On the right-
hand side of the window is the file list. This shows the files and folders
contained within what is selected in the navigation pane. Above the file
list is the search box. This is used to locate files and folders, as discussed
in the next section.

Copyright Goodheart-Willcox Co., Inc.

Chapter 4 File Management 137

i = | Diive Togls ;
e S

...... E New inem e

Address bar

<] Basy access =

‘: - e B This PC + VA v G Taaeh Windawsd (T3 4
2 Downloads A Name
. Racent places
B acatR SRecycle i
Config i
2 8 This pe e .
: s 2 Documents and Settings
¥\ Lesiiop MACRO
v 7 Documents
T MSOCache
a
- M" e .. Outlook Archive
3
i p-ui«: Parftogs
i Pictures
. Photoshop Working Folder
F Wideo
| e — Program Files
o Prograrn Files (<36
2 $Recycle.Bin
ProgramDats
Config.Msi N ——
em Wolu Lt
Bl v@ Documents and Settings % i i
| emp
. . : MACRO
; U
Navigation 7] NSOCache e
Indonats
O Archive
pane utiook Archiv . Working Folder
Pediogs
; bogtmgr
Phatoshap Working Folder SN : :
Program Files B File list
4 v o hibedilsyz 4
im Files
rogr \ pagefilesys SAYNS 1154 a0 A
Pragrmbata
. - swpfile.ys RN SAIFM  SesteniHile
System Volume Information
I temp
I Users
= Windows
Warking Falder
52 COPHOTOS (WGWPDCFSIT) ¢H) v 3

1 items ,511 =

Goodheart-Willcox Publisher
Figure 4-6. Windows File Explorer is used to locate and manage files in the Windows operating system.

The list of available drives and folders shown MSOCache
in the navigation pane is a tree. A file tree can S}l(kk tg , uork rchie
be expanded to display subfolders and the files bg?f;h\& phminpwwng Kol
contained within them, as shown in Figure 4-7. HIox e Progmm il
Each folder in the tree is called a branch. The Bl
last item in an expanded branch is called a leaf. ‘ en-US
To expand a branch in the file tree, move the S}iﬁ;;g / :;:ges
mouse over the folder name until a triangle is T SIGNUP
displayed to the left of the folder icon. Then, click I Mictosaft Office
the triangle. If the folder contains subfolders, Goodheart-Wilicox Publisher
they will be displayed indented below the parent Figure 4-7. The navigation pane displays the folder
folder. To collapse a branch in the file tree, click structure using a tree metaphor.

the triangle next to an expanded branch.

There are several folder views in which
the content of a folder can be displayed. Some of these views include
changing the size of the icons for files and folders, displaying the icons in
a list, and displaying detailed information about the files and folders.

Folders

Folders provide an organizational tool that can be used to keep
similar files together. Similar files may be related to the same event, of the
same file type, or for any reason meaningful to the user. A folder having
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User’s folder the current user’s name appears by default on the
/ = Windows desktop, as shown in Figure 4-8. This
is the user’s Documents folder. Double-clicking
a folder on the desktop launches Windows File
Explorer, which displays the content of the folder.

HANDS-ON EXAMPLE 4.1.1 (cCoNTINUED)

2. In Windows 8, click the View tab, click the Navigation Pane button, and click Show libraries in the
drop-down menu so it is checked. Leave it checked if already checked. This ensures libraries are

i {0 3

Ry ; 3

L s 2l e I5eieeli= g1
| B LI e

file a fraudulent tax return. folders that are displayed together, but that may be stored in different 9. Select an image file by single-clicking it. Notice the details pane updates with information about
= rpzﬁgiundggg[;zg; turn, locations. A library d}isp.lays_; all of the common file.s available to all users the file and the menu bar contains more options. The details pane is turned off by default in
' reports information that ?ﬂd the cun:ent user s files in the el LG The library structure was Windows 8. To turn it on, click the Details Pane button in the Pages group on the View tab of the
is fiot corract. A person introduced in Windows 7 to‘ help multiple users run the.same computer. #HEB .
who intentionally files Unlike a folder, there is no file or folder connected to a library. If a library
a tax return that is not is deleted, the files and folders displayed in the library are unaffected.
accurate may be subject The idea behind a library is there may be several folders on the disk
to penalties, interest, and drive containing similar files that commonly need to be accessed at the ’ . " .
passible prison time. same time. For example, the Pictures library, which appears in Windows Displaying File Name Extensions F Y I
- File Explorer in the Libraries branch, displays the folders My Pictures and By default, the file name extensions are hidden by the operating

Figure 4-8. The user’s Documents folder appears by
default on the Windows deskiop.

A general rule of thumb is to keep only as
many files in a folder as can be displayed in
Windows File Explorer without scrolling. If there
are more files than that, it is likely the files can be
organized into subfolders. For example, suppose a
user creates a folder name SchoolWork within his or her Documents folder.
Ttems in the Documents folder that are related to schoolwork can then
be moved into the SchoolWork folder. This reduces the number of files
located in the Documents folder.

A folder is simply a special type of file. Therefore, follow the same
naming rules used for other files. However, as stated earlier, a folder
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visible.

3. Locate the elements of the Windows File Explorer window shown in Figure 4-6.
4. Single-click the Libraries branch in the navigation (left-hand) pane. The defined libraries are

displayed in the file list in the right-hand pane.

5. Double-click the Pictures library in the file list. The Libraries branch is expanded in the navigation
pane, the Pictures branch is highlighted, and the content of the Pictures library is displayed in the

file list.

6. In Windows 7, double-click the Sample Pictures library in the file list. Note: Windows 8 does not

include any of the sample files and folders found in Windows 7.

7. In Windows 8, click the View tab, and click Medium Icons in the Layout group. In Windows 7,

click the View pull-down menu, and click Medium Icons in the menu.

Ethilcs 3 £ fl —— 8. Applying what you have learned, expand the tree in the navigation pane to show the folders
name coes not have a e hame extension on the local drive, the subfolders within the Windows folder, the subfolders within the Web
Libraties subfolder, the subfolders within the Wallpaper subfolder, and the files within the Windows
Tax Returns subfolder (C:\Windows\Web\Wallpaper\Windows). This nested folder should contain at least one

It is unethical and illegal to

HANDS-ON EXAMPLE 4.1.1
WINDOWS FILE EXPLORER

The ability to effectively use Windows File Explorer is an essential skill for any computer
user. Begin by learning the different elements of Windows File Explorer and how to navigate the
folder and library structures. Note: libraries are disabled by default in Windows 8.1.

1. In Windows 8, launch File Explorer by clicking the Apps button and then clicking File

Explorer in the Windows System group of the Apps menu. In Windows 7, right-click on the
Start menu button, and click Open Windows Explorer in the shortcut menu.

In Windows File Explorer, a library is a collection of similar files and

Public Pictures. These folders are not subfolders within a folder named
Pictures, they are simply displayed in the library named Pictures for easy
access. This is the concept of libraries.
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image file.

system. This can lead to confusing situations if there are several files with
the same name, but different file name extensions. Turning on the display
of file name extensions can help the user tell one file from another file
with the same name.

For example, it is a common practice to name image files by the
content of the image. The files Jellyfish.jpg and Jellyfish.bomp are both image
files. However, with the file name extensions hidden, the user will see
both files as only Jellyfish when viewed in Windows File Explorer. It is
only when the file name extensions are displayed that the difference
between the files becomes clear, as shown in Figure 4-9.

Copyright Goodheart-Willcox Co,, Inc.

The icon associated with
a file helps indicate the
file type, but many file
types share the same
icon or similar icons.
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Figure 4-9. File name extensions are hidden by default, but can be displayed.

TITANS OF TECHNOLOGY

David A. Huffman, a computer scientist and defined a compression scheme whereby none of

compression technologies. This award recognized (HDTV) broadcasts. The technelogy is also used
his invention of the Huffman minimum-length in fax machines and modems. The compression
lossless data-compression code. The compression method is known as Huffman encoding. Huffman
code was the topic of a term paper he wrote while a  was also very interested in origami, the ancient

file compression tended to lose some or much techniques.
of the fidelity of the original file. Huffman’s idea
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inventor, was an early pioneer in the development the data were lost. Decompression restored the file
of computers. He won many awards. However, the to its original fidelity. This data compression method
one he earned in 1998 from the |EEE Information has since been used to compress image files as

Theory Society made a big impact on data well as the data stream for high-definition television

graduate student at the Massachusetts Institute of Japanese art of paper folding. He contributed to the
Technology in 1952. Before his method was used, branch of mathematics involved in the paper folding

HANDS-ON EXAMPLE 4.1.2
DISPLAYING FILE NAME EXTENSIONS

File name extensions are hidden by default. However, many users prefer to have file name
extensions visible. This is a simple setting in Windows.
1. In Windows 8, launch File Explorer. In Windows 7, launch Windows Explorer.

2. Applying what you have learned, navigate to the C:\Windows\Web\Wallpaper\Windows folder.
3. In Windows 8, click the View tab, and click the Options button (not the drop-down arrow below
it). In Windows 7, click the Organize button on the toolbar, and click Folder and search Options in

the drop-down menu that is displayed. The Folder Options dialog box is displayed.

4. Click the View tab in the dialog box. Notice all of the settings for how files are displayed.
5. Scroll down in the Advanced Settings list, and uncheck the Hide exiensions for known file types

check box, as shown.

Felder Options ﬂ

sl Vew [aai]

Folder views

You can apply this view [such as Details or lcans) to
all folders of this type. !

[ ApplytoFolders 1| |

| Beset Folders i

Advanced settings: |

[] Display the full path in the title bar A~
Hidden files and folders
{2) Don't show hidden files. folders. or dives

| {®) Show hidden files, folders, and diives

Uncheck =] Hide emply drives

™ Hide extensions for known file types

Hide folder merge conflicts

[] Hide protected operating system files [Recommended)

[ Launch folder windows in a separate pracess

[] Restore previous folder windows at lagon

Show drive letters |

Show encrypted or compressed NTFS files in color v i

| o e s st
[ | Restore Defaults |

6. Click the Apply to Folders button at the top of the tab so file name extensions will be displayed in

all folders.

7. Click the OK button to apply the change and close the dialog box. Notice the file name extension
is displayed for the file in the folder. In this case, the file in the folder is in the JPG format, which

is a graphics file.
8. Double-click on the file to open it in the program associated with the .jpg file extension.
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Renaming Files and Folders

Often, a file or folder must be renamed. This may be done to correct
spelling, make the name more descriptive, or simply to change the name to

suit the user. However, only the file name should be changed, not the file
F Y I name extension. If the file name extension is changed, the file association
may be broken. This may make the file unrecognizable by the associated

software.

There are several ways to rename a file or folder in Windows File
Explorer. One way is to right-click on the file or folder and click Rename
in the shortcut menu. Another way is to single-click twice on the file or
folder in the file list. A third way is to select the file or folder in the file list,
and then in Windows 8, click the Rename button in the Organize group on

Two single clicks must
have enough time
between them so the
operating system will
not interpret the clicks
as a double-click.

the Home tab of the ribbon. In Windows 7 click Rename in the File pull-
down menu. With any of these methods, the file name is replaced with an
edit box, and the current file name is highlighted and ready for editing.
Once the file name is highlighted, edit the name, and press the [Enter] key
once to complete the process.

A ) & A = /l

NAMING FOLDERS

Removable media, such as flash drives, are commonly used by students to maintain
schoolwork. In Chapter 2, you began setting up a flash drive for use in this class. Now you will
add folders to this device for a class named Physical Science.

1. Insert the flash drive set up in Chapter 2 into the computer. If the AutoPlay dialog box

appears, cancel it.

2. Launch Windows File Explorer.

In the navigation pane on the left, highlight the PRINC-OF-IT flash drive.

4. Click the arrow to the left of the drive icon for the flash drive to expand the folder tree for
the drive. Currently, the drive contains no folders (unless folders have previously been
added), so there is nothing to expand.

5. Make sure the flash drive is highlighted in the navigation pane. When creating a folder, it
will be placed in whatever location is currently highlighted in the navigation pane.

6. In Windows 8, click the New Folder button in the New group on the Home tab of the ribbon.
In Windows 7, click the New Folder button on the toolbar. A new folder is added to the file

@
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indicates it is a subfolder.

menu.
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HANDS-ON EXAMPLE 4.1.3 (CONTINUED) |

list, and the default name of New Folder is highlighted for editing. The folder tree for the flash
drive also is automatically expanded in the navigation pane.

Change the default name to SciencePhysical, and press the [Enter] key to finish creating the folder.
Highlight the SciencePhysical folder in the navigation pane.

Applying what you have learned, add a subfolder named BoilingLab in the SciencePhysical folder.
Click the arrow to the left of the SciencePhysical folder in the navigation pane to expand the
folder tree. The BoilingLab folder is displayed below the SciencePhysical folder in the tree, which

11. Right-click on the SciencePhysical folder in the navigation pane, and click Rename in the shortcut

12. Change the name of the folder to PhysicalScience, and press the [Enter] key. Notice how the
BoilingLab subfolder remains in the parent folder even after the parent is renamed, as shown.

BN

PhysicalScience

= n“

®
4
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\ LOCATING FILES AND +| SECTION
| | [SECTION REVIEW ] FOLDERS
H | ‘ P CHECK YOUR UNDERSTANDING 1C3 CERTIFICATION PRACTICE _ _
it 1. What are the three parts of a file name? The following question is a sample of the types of Itk Morurilsial 1o hiesr novice
2 N arg thervwe parts of fheifis paihe? questions presented on the IC3 exam. computer users say that they cannot
3. Write this file name in CamelCase: My Picture of 1~ The dialog box displays the properties of a file. firie f1 26 ey mfeated. TiHE: s
g What is the file size? explained by the fact that disk drives
wnloelng, A 16.045 KB may have gigabytes or terabytes of
- m]at * aIcI;brary " WIH?EWZ.EXFWB;;?.I B. Nc;t displayed storage space and contain hundreds or e i
5 it turn on the display of file name C. 15.6 KB thousands of folders. However, being |, yOU:\\
D. 15.6 MB unable to locate a file often means the "
: g ability to locate
s user did not have a plan for saving il s aE s
e - B and locating files. iHpan ;’
lt-__'__'__'_____.' . ProJect_H:‘snth_ry Properties i Windowrs pI‘OVi s an productivity?
| Gooma [ Seaty | Deiad ] Previns Vardors organizational plan for collecting files
@ [Faeanee of a similar type in one location. This organizational
| o R scheme includes folders for My Documents, My Music, My
| TR M Pictures, and My Videos. However, many users create
| o Wil mmE custom folders to group files according to their own
= T T— ways of working. Some choose to group files by
5 | sz 1SEKB(1E04S btes creation dates, while others group files around a certain
: | Smondik 180KB (1634 bytes topic, such as vacations or school courses. Each person
should choose a scheme that makes sense for him or her
and that will support rapid retrieval of each file. A good
i uide is the English proverb, “A place for everythin
CJ» BUILD YOUR VOCABULARY gnd everythinggjn itspplace.” F .
As you progress through this course, develop a
personal IT glossary. This will help you build your
vocabulary and prepare you for a career. Write a
definition for each of the following terms and add it to
your IT glossary.
CamelCase folder name
file association library
file name naming convention
file name exiension nested
file path reserved symbols
file tree subfolder
‘ folder
| &
1
| =
I | - N
[ [ERMS g LEARNING GOALS
: file management ® Locate files and folders on a computer system.
! root ¢ Sort the list of files in a folder.
| sorting
' wildcards
A \_
Copyright Goodheart-Willcox Co., Inc. Copyright Goodheart-Willcox Co., Ine.




146  Unit 1 Computing Fundamentals Chapter 4 File Management
Locating Files and Folders Searching Inside Files
Gomputing File management is working with files on the hard disk or other By default, Windows File Explorer searches inside certain file types.
Fundamertals storage medium. Good management involves organizing files in logical During a search, Windows not only looks for file and folder names that 1
1.2.] locations. Doing so makes it easier for users to recall where a file is saved. meet the search criteria, but also looks at the content of these files. For |
All files are stored in a hierarchy that begins at the top folder of the example, the DOC and DOCx file types are by default set to have the |
drive. This top folder is called the root. For example, some folders that content of the file searched. If a search is conducted with the phrase I‘
exist at the root of the primary hard drive in the Windows operating boiling, the results would include not only the files BoilingLab01.xsx Instead of setting l
system include Program Files, Users, and Windows. The file path begins at and BoilingLab02.xlsx, but also the file Results.docx if the word boiling is Windows to search ‘.
| the drive root. contained in that document. the content of all file
) Windows can be told to search the content of all file types. This may types, it is possible to ‘
e Searching for Files be useful, but it may also increase the amount of time it takes to conduct add specific file types
Tg??m The search box in Windows File Explorer is used to locate files and a search_. In Windows 8?’ Gick e Option§ bationon ’,[he right-hanc-l Side o e hst (.)f Blesrwhose
folders. To conduct a search, first highlight the drive, folder, or subfolder of the View ribbon of File Explorer. In Windows 7, click Folder options... content will be searched
to search in the navigation pane. The default text in the search box reflects in the Tools pul%—do.wn menu of Windows Explorer. In the Folder Options using the Indexing
what is selected. For example, if the Deskiop branch is selected in the dialo.g box that is displayed, click the Search tab, as shown in Figure 4-10. Options link in the
: navigation pane, the default text in the search box is Search Desktop. In Wmdoxlfvs 8, check ’Ehe Always search file names and contents check Control Panel window.
A file search will take Next, click in the search box and enter the name of the file or folder box. In WJ_.ndows 7, click the Always search file names and contents radio
less time if the search is for which to look. If the entire name is not known, a partial name can be button. Click the OK button to apply the setting and close the dialog box.
the content of a specific entered. When the [Enier] key is pressed, the search begins. A greenbar & e —
folder rather than an slides across the address bar to indicate the search progress. Every file 1 ~ Folder Options [ x|
entire drive. found matching the search criteria will be displayed in the file list. Scroll | | Genal | View | Search | _ i ko |
- through the list to locate the correct file or folder. ‘ | Howtoseach I
Sometimes the list of files found is longer than a user wants to sift b | ORrpmmsmieepadignidtmiosrysom | | §
through. Suppose a user was hunting for a picture file and simply entered T i e v }
! pictures in the search box. Many unwanted files would be suggested. the corttent of ||| linchds sysen dieciores

Narrowing the search criteria will speed up locating the file. Wildcards all file types Bl et )

can be used in the search box to represent unknown characters. An

' asterisk (*) represents one or more characters in a file name. A question
mark (?) represents just one character.

- For example, to find all of the boiling lab files, enter beiling*. To find i i
‘ the boiling lab files that end in 1, enter boilinglab?1. This will return the il '
files boilinglab01 and boilinglabi1. However, the file boilinglab111 will not be il H
returned because there is an extra character and the ? wildcard allows for 1
one character. ; - ) '
| It is possible to search for only files of a certain type by entering the | [ |[ I
| asterisk wildcard and the file name extension. For example, to locate all —
JPEG images, enter *.jpg. This method can be combined with part of the
file name to limit the search by file type. For example, to locate all boiling
lab files that are in Excel format, enter boiling*.xlsx or boilinglab*.xIsx.

iAIways search hle names and contents ii'his might take.
several minutes)
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Figure 4-10. By default, Windows searches the content of certain file types, but it
can be set to search the content of all file types.
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HANDS-ON EXAMPLE 4.2.1

Click the drop-down
arrow in the header
in the file list to show
additional sorting
options.

SEARCHING FOR FILES AND FOLDERS

The ability to search for files is critical to becoming a successful computer user. It is not
uncommon for a computer user to work with hundreds if not thousands of files over the course of
a year. Even the best computer users will need to search for files and folders.

1. Launch Windows File Explorer.

2. Expand the folder tree for the primary hard drive (C:) in the navigation pane on the left,
and highlight the Windows folder. The search box should display Search Windows.

3. Click in the search box. The default text is replaced with a vertical bar cursor. For a few
seconds, a list of recent search phrases is also displayed.

4. Enter *.jpg in the search box. When the [Enter] key is pressed, the search begins.

5. A green bar appears in the address bar to indicate the progress of the search. When the
green bar reaches the right-hand side of the address bar and disappears, the search is
complete. The file list displays the files found in the Windows folder, as well as all of its
subfolders, that are of the JPG type.

Sorting Files

Sorting is arranging a list by a certain criterion, such as
alphabetically, by date, or by size. This can help locate the file or folder.
By default, Windows File Explorer shows files sorted alphabetically by
name, from A to Z. Sorting files by date is also useful to show which files
have been saved more recently than others. Sorting by date is especially
useful if multiple versions of the same file exist in different locations.

To sort files, display the details view. In Windows 8, click the View
tab, and click Details in the Layout group. In Windows 7, click the View
pull-down menu, and click Details in the menu. In the details view,
headers are displayed in the file list, as shown in Figure 4-11. Clicking the
Name header toggles between sorting the files alphabetically from A to
Z and from Z to A. Clicking the Date header toggles between sorting the
files from oldest to newest and newest to oldest. A small triangle pointing
either up or down in one of the headers in the file list indicates which
header is used as the sort criterion. The direction the triangle is pointing
indicates if the sort is ascending (A to Z, for example) or descending (Z to A,
for example).
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Figure 4-11. The details view displays headers, which can be used to sort files.

HANDS-ON EXAMPLE 4.2.2 |
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SORTING FILES

anytime the content of a folder is displayed.
1. Launch Windows File Explorer.
2. Highlight the Windows folder in the navigation pane on the left.

View pull-down menu, and click Details in the menu.

folders are listed before the files.

also sorted in ascending order by date.

order.

Copyright Goodheart-Willcox Co., Inc.

Sorting files is useful when a search returns a long list of files. However, sorting can be useful

3. In Windows 8, click the View tab, and click Details in the Layout group. In Windows 7, click the

4. Scroll through the list of files and folders. When sorted in ascending alphabetical order, all

5. Click the Date modified header so the triangle points down. Notice that the file list displays the
files at the top in ascending order of when they were last modified. In ascending order of date,

the most recent file is at the top. The folders are at the bottom of the list after the files and are

6. Click the Date modified header to toggle the sort to descending order. Now the folders appear first
in the list with the oldest one at the top. The files appear after the list, also sorted in descending

7. Click the Name header so the triangle points up. All of the files and folders are now in ascending
alphabetical order with the folders at the top of the list and the files after the folders.
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[ SECTION REVIEW

J

IZ? CHECK YOUR UNDERSTANDING

. What is the top folder of the file tree called?
. In which utility is the file search option found in

Windows?

. Which wildcard represents a single unknown

character?

. What should be entered to search for all image

files with the .jpg file name extension?

. How are files sorted by date in Windows

Explorer?

IC3 CERTIFICATION PRACTICE

The following question is a sample of the types of
questions presented on the IC3 exam.
1. Select the best choice for the statement. A
computer icon is a(n):
A. file containing the full image of the small one
displayed.
B. folder.
C. small image on a Windows screen that
represents a file or folder.

D. embedded computer.

|'_/|* BUILD YOUR VOCABULARY

As you progress through this course, develop a
personal IT glossary. This will help you build your
vocabulary and prepare you for a career. Write a
definition for each of the following terms and add it to
your IT glossary.

file management

root

sorting

wildcards
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ORGANIZING FILES AND
FOLDERS

Operating systems allow users
to create their own folders and
subfolders. Organizing personal
storage locations helps the user to save
and retrieve data. Using Windows
File Explorer, the user can easily view
and create new folders. When using
an external drive, it is a good idea to
create the same folder hierarchy that
is used on the internal drive. Having
the same organizational scheme across
devices will provide a more efficient
transfer of files folders from one device to another.
Locating files on the external drive will be easier, too.

When files or folders are transferred from one
device to another, they can be either copied or moved.
There is a big difference between copying a file or
folder and moving it. There is an even bigger difference
when files or folders are copied or moved across

devices. This section explains how to copy and move
files and folders.

a file from one folder
to another?

shortcut menu
source

p
TERMS mﬂ FLEARNING GOALS
Qopy ® Explain the difference between copying files and
destination moving files.
drag and drop e Delete files and folders from a computer system.
move
recycle bin

Copyright Goodheart-Willcox Co., Tnc.

What is the mo&\
efficient way to copy

151
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Copying and Moving Files and Folders

oG Files and folders can be easily moved around any storage drive or
Fundamenids between devices. The source is the folder where the file or folder being
1.2.2 transferred is originally located. The destination is the folder to where the
file or folder is being transferred. The transfer can be move or copy.

There are often several methods to accomplish a task in Windows.
Copying and moving files and folders are examples of where there is
more than one way to do something. Particularly useful is the shortcut
menu. The shortcut menu is a point-of-use menu displayed by right-
clicking. Many software programs, including the Windows OS, have
various shortcut menus. A shortcut menu is context-sensitive and
anticipates common actions that a user may take. Context-sensitive means
what is displayed in the menu is based on what was right-clicked. For
example, to copy a file from one drive to another, right-click on that file
and click Copy in the shortcut menu, as shown in Figure 4-12.

FYI

Most standard open
and save dialog boxes
in Windows can be
used to perform some
file management, such
as copying, moving,
renaming, and deleting
files or folders.

Selecting Files and Folders

To select, or highlight, a single file or folder, simply single-click it
in Windows File Explorer. However, there are a couple of ways to select
multiple files or folders. Once a selection is made, whether it consists of a
single file or folder or multiple ones, it can be copied, moved, or deleted.
One way to select multiple files or folders is to drag a selection
window around them in Windows File Explorer. Click in a blank area

above the first file or folder name to select, hold down the left mouse
button, and drag to the last file or folder to select. As you drag, a box

Right-click
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Figure 4-12. The shortcut menu can be used to copy or move a file.
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called a selection window is drawn. Any files or folders within the
selection window will be selected, as shown in Figure 4-13. When the
files and folders to select are highlighted by the selection window, release
the left mouse button. This method only works to select files or folders in
sequence.

Another way to select files or folders in sequence is to use the [Shift]
key. This is often easier than trying to drag a selection window. To use this
method, click the first file or folder to select it. Then, hold down the [Shift]
key, and click the last file or folder in sequence. The first and last file or
folder and all files or folders between them are selected.

To select individual files or folders that are not in sequence, the [Ctrl]
key must be used. Hold down the [Ctrl] key, and then click the files and
folders to select. The files and folders do not need to be in sequence, but
they must be in the same parent folder.

Copying Files and Folders

A copy of a file or folder is an exact duplicate of the original at the
time the copy was made. When a file or folder is copied from one folder
to another, there are two versions of the file. One version exists in the
source folder and one version exists in the destination folder. To copy a
file or folder using the shortcut menu:

1. Right-click on the file in the source folder. This selects the file and

displays the shortcut menu.

2. Click Copy in the shortcut menu. A copy of the file is placed on the

system clipboard.
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Figure 4-13. Multiple files can be selected by dragging a window around them.
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If the source and
destination folders are
the same, the copy is
automatically renamed
to end with — Copy to
avoid conflicting file
names.

Unit 1 Computing Fundamentals

Click to
overwrite the file
/

3. Select the destination folder in the navigation pane.

4. Right-click in a blank area of the file list, and click Paste in the
shortcut menu. A copy of the original file is created from the content
on the system clipboard and placed in the destination folder.

On occasion, a file of the same name may be in the destination
folder. Windows will prompt the user to choose what to do, as shown in
Figure 4-14. There are three options:

¢ Copy and Replace

® Don’t copy

® Copy, but keep both files

The Copy and Replace option overwrites the
file or folder of the same name in the destination
folder. This means the original file in the

=

Figure 4-14. If a file of the same name exists in the
destination folder, you are asked what to do.

Copying 1 item frgm Flowers to Lines and colors

The destinatjon already has a file named “img7 jpg”

CEE

destination folder will be gone. It is important to
i be sure that it is appropriate to overwrite the file
or folder in the destination folder before choosing

this option.

H [ . . . i | : . i
n Replace the file in the destination . 3 i The Don’t copy option cancels the action. The

¥ Skip this file

[y Compare info for both files

(¥ More details

tile or folder remains in the source folder. The
file or folder of the same name in the destination
folder is also unaffected. Choosing this option

. provides an opportunity to go to the destination
i folder, determine whether or not the file or folder

with the same name may be deleted, and then
restart the copy procedure, if appropriate.

The Copy, but keep both files option preserves
the file in the destination folder. The copy being
created is placed in the destination folder with the
original name appended with a number. Choosing this method provides
an opportunity to examine both files.
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Moving Folders and Files

To move a file or folder means to remove it from the source folder
and place it in the destination folder. When a file or folder is moved, there
is only one version of it. After the action, the file or folder appears only in
the destination folder. To move a file or folder using the shortcut menu:

1. Right-click on the file in the source folder. This selects the file and

displays the shortcut menu.
2. Click Cut in the shortcut menu. The original file is removed from
the source folder and placed on the system clipboard.

3. Select the destination folder in the navigation pane.
4. Right-click in a blank area of the file list, and click Paste in the

shortcut menu. The original file is placed in the destination folder.
It also remains on the system clipboard.

The only difference between the procedures for copying and moving
using the shortcut menu is the file or folder is cut instead of copied.
Cutting removes the original from the source folder and places it in the

Copyright Goodheart-Willcox Co,, Inec.
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destination folder. In effect, the file or folder is moved to the destination
folder. If the destination folder contains a file or folder with the same
name as the original, the user is prompted to choose what to do, just as

with copying a file.

Other Methods to Copy and Move

There are keyboard shortcuts that can be used to copy and move
files and folders. To copy a file or folder, first select the item. Then, press
the [Ctrl][C] key combination. This copies the file or folder to the system
clipboard. To move a file or folder, select the item, and press the [Cirl]

[X] key combination to cut the item. To complete either operation, select
the destination folder in the navigation pane, and press the [Ctrl][V] key
combination to paste the content of the system clipboard. To undo an
operation, press the [Ctrl][Z] key combination. Note that the keys [Z], [X],
[C], and [V] are next to each other on the keypad, which makes it easy to
complete these common tasks with the left hand.

Another alternate method to copy or move a file or folder is to drag
and drop it. Drag and drop is a procedure in which an item is selected
in one location, moved with the mouse, and placed in another location.
To drag, click the item in the source location, hold down the left mouse
button, and move the mouse to the destination location. To drop, release
the mouse button. To cancel a drag and drop, press the [Esc] key before
dropping the item. When drag and drop is used between two drives, the
operation is copy. When drag and drop is used between locations on the
same drive, the operation is move. It is important to remember this default
behavior.

The default drag and drop behavior can be modified with the
[Ctrl] and [Shift] keys. To copy a file or folder, regardless of whether the
operation is between drives or on the same drive, hold down the [Ctrl] key,
then drag and drop the item into the destination location. To move a file
or folder, hold down the [Shift] key, then drag and drop the item into the
destination location.

Another way to modify the default drag and drop behavior is to
right-click instead of left-click. Right-click on the item to copy or move,
hold down the right mouse button, and drop the item in the destination
location. When the item is dropped, a shortcut menu is displayed that
contains options to copy or move the item or cancel the operation.

HANDS-ON EXAMPLE 4.3.1

COPYING FILES

prefer to drag and drop files instead of using the keyboard.
1. Insert your PRINC-OF-IT flash drive into the computer.
2. Launch Windows File Explorer.

The ability to copy and move files is a critical skill for a successful computer user. Many users
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1.2.2

The keyboard shortcuts
for copy, cut, and paste
can be used in many
software programs to
edit content. The [Ctrl]
[Z] key combination is
standard for reversing
an action.
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Select a group of files
or folders to delete the
entire group in one step.
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3. Applying what you have learned, search the Windows folder for any file with the .jpg file

Select any one image file in the file list by left-clicking on it once.

Hold down the [Ctr] key, and click any two other image files to select them. Because the
[Ctrl] key is held down, the files do not need to be sequential to the first file.

Press the [Ctrl][C] key combination to copy the selected image files.

Select the PRINC-OF-IT flash drive in the navigation pane.

Applying what you have learned, create a folder on the flash drive named Images.
Select the new folder in the navigation pane.

Press the [Ctrl][V] key combination to paste the copied image files into the Images folder.
11. Applying what you have learned, search the Windows folder for any file with the .jpg file

12. Click and hold any image file in the file list, drag the file to the Images folder on the flash
drive, and drop the file. If the file tree for the flash drive is not expanded, hold the file over
the flash drive icon for a couple of seconds until the tree is automatically expanded. Then,
drop the file into the Images folder. Because this operation is across drives, not within the
same drive, it is a copy operation, not a move operation.

Deleting Files and Folders

In order to effectively manage files, you need to be able to remove
files and folders that are no longer useful. In Windows, deleting a file
or folder is a simple process. Restoring a deleted file or folder is also a
simple process.

Deleting

To delete a file or folder, select it and press the [Delete] key or right-
click on it and click Delete in the shortcut menu. In Windows 8, you can
also click the Delete button in the Organize group on the Home tab of the
ribbon in File Explorer. In Windows 7, you can also click the Organize
button on the Windows Explorer toolbar and then click Delete in the
drop-down menu. No matter which method is used, a dialog box appears
asking to confirm the deletion. Click the Yes button to delete the selected
file or folder. Click the No button to cancel the operation.

Restoring

When asked to confirm a deletion, the dialog box asks Are you sure
you want to move this folder to the Recycle Bin? Windows uses the concept
of a recycle bin as an undelete function for deleted files and folders. The
recycle bin is a special folder used as a collection point for all files and
folders that have been deleted. It can hold a certain volume of deleted
material, and the maximum size can be changed. As long as a deleted file
or folder is stored in the recycle bin, it can be restored or undeleted.
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To restore a file or folder, display the content of the recycle bin. This
can be done by double-clicking the Recycle Bin icon on the desktop or, in
Windows 7, by selecting the Recycle Bin branch in the navigation pane in
windows Explorer. With the content of the recycle bin displayed, right-
click on the file or folder to restore, and click Restore in the shortcut
menu. In Windows 8, you can also select the file or folder, and click the
Restore the selected items button in the Restore group on the Manage on-
demand tab in the ribbon. In Windows 7, you can also select the file or
folder, and click the Restore this item button on the toolbar. Once restored,
the item is removed from the recycle bin and placed in the location from

where it was deleted.

The recycle bin is a folder, and its content takes up storage space. To
free this storage space, the recycle bin can be emptied. However, doing
S0 permanenﬂy removes the deleted files and folders, and they cannot
be restored. To empty the recycle bin, display its contents. Then, in
Windows 8, click the Empty Recycle Bin button in the Manage group on
the Manage on-demand tab of the ribbon. In Windows 7, click the Empty
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Carcar
Slkill's

Graphic Artist
- Graphic artists are often
| called on to determine
| which file format to use for
| an online production. They
- must learn to balance the
- image quality with the
| file size. Their aim is to
produce the finest quality
- image while ensuring the
. smallest file size for fast
. transmission, all without
- violating the integrity of
 the original image.

Recycle Bin button on the toolbar. A message appears asking to confirm
removing the items from the recycle bin. Click the Yes button to remove
the items or the No button to cancel the operation.

——

43 | [SECTION REVIEW

)

@ CHECK YOUR UNDERSTANDING

1.

2.

The is a point-of-use menu displayed by
right-clicking.

How do you select a file or folder in Windows
Explorer?

What is the difference between copying a file and
moving it?

What is the key combination for cutting a file
instead of copying it?

. What is the location in Windows from where a

deleted file can be restored?
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IC3 CERTIFICATION PRACTICE

The following guestion is a sample of the types of

guestions presented on the 1C3 exam.

1. Perform this simulation.
Locate the file named Lighthouse.jpg in the C:\
Libraries\Pictures\Sample Pictures folder, and
move it to the folder C:\Libraries\Pictures\Sample
Pictures\Flowers.

P BUILD YOUR VOCABULARY

As you progress through this course, develop a
personal IT glossary. This will help you build your
vocabulary and prepare you for a career. Write a
definition for each of the following terms and add it to
your |T glossary.

copy recycle bin
destination shortcut menu
drag and drop source

move
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How would society
be impacted if social
| media websites did not

CTION

Windows Explorer is an
example of a file utility. File utilities
perform common functions such
as backing up and restoring files
as well as displaying and editing
a file’s properties. These programs
are called utilities because they help
the user perform useful, repetitive
tasks. One of the most important
file-management tasks is to back up
files in the event that the original
files are lost, deleted, or corrupted. Utilities also assist
in determining the most recent version of a file.

Sending large files as attachments to an e-mail
message or copying large files to a flash drive may be
a problem. Large files take more time to COpYy Or move
through the e-mail network. A file utility that can make
files smaller is an advantage here. Utility programs can
be accessed through the Control Panel window and
through the Accessories folder in the Apps or Start menu.

ack up their data?

LEARNING GOALS
® Use the Windows help system.
Explain the properties associated with a file.

Describe the process of backing up files and folders.
Discuss file compression methods.

—
®

— | /

FILE UTILITIES

Steve Culkrov/Shutterstock.com

B
TERMS i

backup

extracting

file attribute

file compression

file properties

help

|
[3 system image

N w
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windows Help

Help is a resource to assist the user in learning how to use a feature
of the program. It is a knowledge database of topics related to the
software. Help is provided by almost all software programs, including the
Windows operating system.

The help feature for Windows File Explorer can be launched by
clicking the Help button (question mark) in the upper-right corner of the
window. The Windows Help and Support dialog box is displayed. Because
help was accessed from within Windows File Explorer, the initial content
displayed is related to file management. However, the Windows Help and
support dialog box is the interface for the entire Windows help feature.

At the top of the Windows Help and Support dialog box is a search
box. Enter a word or phrase related to the topic you wish to view, and
click the Search button (magnifying glass). A list of related topics is
displayed. The name of each topic is a hyperlink. Clicking the hyperlink
displays the full article. For example, if the phrase folder management is
entered in the search box, a list of topics related to managing files, folders,
and other items is displayed.

Windows will try to rank topics in an order most likely to match
the search phrase, but do not assume the first topic will contain the
information you seek. Carefully read the name of each topic. Evaluate
how closely the words in the title match the search phrase. Once you
have determined which topic is most likely to contain the information
you seek, click the hyperlink. Then, scan the article to see if it appears to
contain the information. If not, click the Back button and evaluate other
topics. Otherwise, read the details of the article.

File Properties

The file properties are all information about
the file, but not the data contained within the
file. Properties include, among other things,

The help feature for
Windows can also be
accessed through the
Apps or Start menu.
When accessed in this
way, the initial topics
are for Windows in
general.

the creation date, date of the last save, current

Typeof fle:  JPG Fite (jpg)

permission setting, and whether or not it is J | Crenenttc  Foler [_Chenge. |
hidden. The file properties are displayed in the U focation  cwindonswsbwelpapenTheme2
Properties dialog box. To open this dialog box, i e 105 KB (107574 bytes)
right-click on a file, and then click Properties in Tile /1 Sieondisk: 108 KB (110,552 bytes)
the shortcut menu. information | 10e i Tiasdy, Augusi 22, 2013, 15255

In most cases, there are three tabs in the Modfied:  Tuesday, June 18, 2013, 10:20:21 AM

Properties dialog box, as shown in Figure 4-15:

General, Security, and Details. In Windows 7, there
is usually a fourth tab named Previous Versions. In
some cases, depending on the file type and system
configuration, there may be more tabs. Under each

Attributes:

Accessed:

Thursday, August 22, 2013, 1:52:55 &M

[(IRead-anly [ ] Hidden

tab are options and settings that may be displayed

or edited. e

‘ 0K JE Cancel : Apply

Goodheart-Willcox Publisher

Figure 4-15. The Properties dialog box contains

information about the
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General Tab

The General tab of the Properties dialog box lists information such as
the file type, the size of the data contained and the size of the file on the
disk, and the path to the folder where the file is located. The file name is
displayed in a text box at the top of the tab and may be renamed there.
Also listed are three dates and times.

® Created is the date and time when the file was created.

e Modified is the date and time when the file was last changed.

® Accessed is the date and time when the file was last opened, but
not saved.

The software program associated with the file type is indicated in the
Opens with: area. This is the software that will be launched when the file
icon is double-clicked in Windows File Explorer. To change the associated
software, click the Change... button. In the Open with dialog box that is
displayed, a different software program can be selected. The association is
applied to all files of the file type.

Afile attribute is a characteristic of a file about the display, archiving,
and save status of files. There are two file attributes that can be set on the
General tab:

¢ read-only

e hidden

Good file management is a key to successful computing.
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Read-only permits no editing, saving, or deleting. Check the Read-
only check box to guard against accidental overwriting. Users may view
it, but may not overwrite it. Hidden keeps the file from being listed in
Windows File Explorer. Many system files have the Hidden check box
checked. Clicking the Advanced button opens a dialog box in which other
settings regarding the save process for a file can be made.

Security Tab

The Security tab of the Properties dialog box permits the author to
modify the permissions for sharing a file with other users on a network.
Windows lets users form a workgroup when PCs are connected to a
network. In addition, multiple users on a Windows PC may share files
with one another. Some users only require need-to-know access to a file’s
contents. Permissions allow restricted access to a file. Permissions are an
extension of the Read-only attribute available on the General tab.

For example, people may be working on developing a certain project
as a group. Instead of carrying the common files around on a flash drive,
Windows allows users in a group to see each other’s files on their own
computers. This means they can allow other users to modify the file or
simply read it. One user may create a file and give permission to other
users to view the file content, but not change it. For example, it may be a
final version that has been adopted in some manner and no one should be
able to change it unless authorized. These permissions are settings in the
file properties.

Details Tab

The Details tab of the Properties dialog box provides extra data about
the creation of the file and information related to authorship. On this
tab, the file can be assigned a title and subject, rated, tags added, and
comments added. It is here that the author’s name may be entered. The
tab also summarizes all of the selections on the first two tabs. This tab is
context-sensitive and differs by file format.

Previous Versions Tab

The Previous Versions tab of the Properties dialog box lists when the
file was backed up and supports restoring an earlier version of the file.
This is very helpful if changes have been made and the file saved, thereby
overwriting the earlier version. If the user decides not to make those
changes, an earlier version of the file can be retrieved from the backup
files. This function applies only to files that have been backed up with
Windows Backup and Restore, which is discussed later.

The information on this tab also helps when a program crashes, or
unexpectedly stops working. When Windows crashes, it is expected to try
to restore the user’s work from previous saved versions. The information
on this tab provides details to step through the restore operation.
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Engineering

Engineering applies
scientific theory to the
design of materials for
technological use. There
are many branches of
engineering, but the

main branches are
chemical engineering,
civil engineering,
electrical engineering, and
mechanical engineering.
Each branch has
subdisciplines, which
each have specialties. For
example, a subdiscipline
of civil engineering is
structural engineering,
which specializes in
architectural engineering.
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" HANDS-ON EXAMPLE 4.4.1

FILE ASSOCIATION

By default, in Windows the JPG file type is associated with an image viewer, such as Photos
or Windows Photo Viewer. However, it may be more efficient to have the image file opened in an
editor, such as Microsoft Paint.

1. Launch Windows File Explorer.

2. Applying what you have learned, search the Windows folder for any file with the .jpg file

extension.

3. Right-click on any image file, and click Properties in the shortcut menu.

Click the General tab in the dialog box.

5. Look at the program listed in the Opens with: area. The default program is Windows Photo
Viewer.

6. Click the Change... button. In Windows 8, click More Options and then Look for another app
on this PC. The Open with dialog box is displayed, as shown.

=

Navigate
to this folder Select

= en with.., —E
e SV 5 - + |
f:{_.:) - 4 <« VWindows » Systern32 p v & Search Systemn32 ¥l |

Organize v Mewfolder =~ O @
b Fiiis A Name Dats modified * ||
B Desktop B mshta.exe 82073 6290 |

& Downloads 15! msiexec.exe Bf2a/a3 23

%21 Recent places [?}' msinfol2phe 8/22/2013 5:392

(2] mspaint.exe B/22/2013 547

i ThispC A msraexe 9/29/2013 11,03

f Ja Desktop {7} MsSpellCheckingHost.exe /222003 417 ¢
£} Dacurnents %) mstscexe BI2/2013 506 |
B Downioads 7 mtstocom.exe 82223 445~ |

U Music [ MuiUnattend. exe B/22/2013 5:504
& Pictures % MultiDigiMon.exe B22/2013 6032 |
B Videos 7 NAPSTAT.EXE Baz2013 613 ||

i Narrator.exe s Et, |
7 nbtstat.exe B22/2012 6274 |

[ ndadmin.exe B2 01 B4 Y
v € > |

i Windows8 (CY)
S CDPHOTOS (\GWPDCFSOT) (H2)
i BMC (\GWPDCFSOT) (M)

File name: Emspaint.exe v Pragrams (.exe;* pifi*.com;".bz vg

‘ Open i . l;':am:el ‘

7. Navigate to the Windows\System32 folder, and select the mspaint.exe file. Click the Open
button. The association for the JPG file type is changed to Microsoft Paint. The Properties
dialog box is updated to reflect this.

8. Click the OK button to close the Properties dialog box.

9. Double-click on any JPG file in Windows File Explorer. Microsoft Paint is launched, and the
image file is loaded into Paint.
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File Backups

A backup is a copy of a file that can be safely retrieved if anything
unfortunate happens to the most recent version of the file. Mishaps
are common in file management. Files can be accidentally deleted,
overwritten, modified, or corrupted. A file becomes corrupted when
something happens to affect the storage location of the file. Users create
backups to ensure that all is not lost if something happens to a file.

Always back up a file
before a significant
amount of work is

to be done and after
that work has been
completed.

163

Saving Copies of Files

The simplest way to back up a file is to save it on a different storage
device. If the user is saving data files on a course flash drive, the files
should also be saved on another flash drive, a server, or in the cloud. An Computing
advantage of using the cloud is that the file is offsite. The cloud service Fincemens

being used also has backup measures to protect the file. When creating a 44.1,44.2,44.3
backup on a different device, the user must remember where the copy is

and to keep it current.

Saving Versions of Files —_—

Fundamentals

Another backup scheme is to save versions of the file. This method 444
allows restoring one of many earlier states of a file, thus reversing T
changes. Most software programs offer a Save As function for saving a
file under a different name. This function can be used to easily create
versions.

For example, suppose a student is working on a file named
TermPaper.docx. It is easy to save a newer version as TermPaperV1.docx,
then TermPaperV2.docx, and so on. The student edits the newest version
and saves it as the next version number after enough changes have
been made that he or she wants to keep intact. After the final version
is complete and the earlier versions are no longer needed, they may be
deleted to clean up the folder.

When working on a team, it is important to establish the naming
convention for creating versions. All members of the team must
understand which file should be in use at any given time. The read-only
attribute is useful in locking all files that should not be edited.

Windows Backup and Restore

Windows includes a backup and restore utility to help automate
these processes. The File History (or Windows Backup and Restore) utility
1s available through the Control Panel window. This utility compresses all
data files and saves them to another disk volume. A disk volume acts like
a separate physical drive, but is really contained on the same drive. The
utility prompts the user through restoring one of the files to the disk. This
utility can also be used to create a system image, as shown in Figure 4-16.
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Click to create

a system image \

|

| ‘E’:} (E}' = 4 4&+ Control Panel + All Contral Panelltems & File History v O Search Cartral Panel o i

‘ Xﬁe:m’er‘v
|| B System Image Backup

File History 7

Control Panel Home . "
Keep a history of your files

Restore personal files
Select drive
Exclude folders

File Histary saves copies of your files so you can get them back if they're lost or damaged.

‘ i Mo usable drive was found. We recommend that ¥ou use an external drive for File History.
Connect a drive and refresh this page, or use a network lecation.

! Select a nebwerk lecatior

Adhvaiiced séltivigs L S

| File History is off

| Copy files from:  libraries, desktop, contacts and favorites
| Copy files to: No usoble drives were found.

Seealso
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Figure 4-16. The Windows Backup and Restore utility is used to back up files and create a system image.

Computing
Fundamentals

34.1,34.3

A system image is a backup that is an exact duplicate of all data on
the drive, including the drives required for Windows to run, your system
settings, programs, and document files. A system image allows you to
completely restore all data to a previous point that was working. This is
usually done to correct a serious problem that causes the system to stop
working.

There are many third-party backup utilities available. Some are
freeware and some are for-purchase software. Most backup programs can
be scheduled to automatically run at periodic intervals established by the
user. It is common to set a backup utility to run overnight when there is
no user activity on the system.

File Compression

The amount of space a file takes up on the disk is not as great of
a concern today as it was when disk drives were very limited in size.
However, when sharing files, file size is a concern. Large files take longer
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to move across a network than small files. Many e-mail services limit

the size of a file that can be attached to a message. Large files take up
more space on an external drive and may quickly fill up the device. The
solution is file compression. File compression is a process of compacting
the data in a file or group of files to reduce the overall size.

When a file is created by a software program, it is generally formatted
so that reloading the file is quick and efficient. As a result, the file may be
larger than it needs to be. Some file-compression technologies eliminate
repeated patterns in a file to reduce the overall size. There are other steps
to take to compress a file, but the result is the same. The original content
of the file is preserved, but the file is smaller.

Many image file types are automatically compressed. The JPG or
JPEG file type is a compressed image file. Trying to compress this file type
or any of the other compressed file types will not yield much reduction in
file size.

Compress Files Using Windows File Explorer

Windows File Explorer provides a utility that compresses one -
file or a group of files at the same time. To do this, first select the file,
group of files, or a folder. Next, right-click on the selection, and click
Send to>Compressed (zipped) folder in the shortcut menu. All of the
files selected are compressed into a single file, which in Windows is
considered a folder. The default name of the ZIP file is the same name
as the first file or folder selected based on the current sort. The ZIP file is
placed in the same location as the original selection. The original selection
is unaltered.

Extract Files Using Windows File Explorer

Extracting is what Windows calls the process of taking a file out of
a ZIP file. Other software may call this process unzipping, unpacking, or
unstuffing. Because the files have been compressed, the original software
for the file association no longer recognizes the file as a type it can read.
The file must be uncompressed.

Double-click on a ZIP file to begin the extraction process. The content
of the file is displayed in Windows File Explorer, as shown in Figure 4-17.
Notice the Extract all button on the ribbon or toolbar. Clicking this button
will copy all files and folders in the ZIP file to their uncompressed
formats. The user specifies the location to where the files will be
extracted. Files and folders can also be extracted using the drag-and-drop
file management method.
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Some compressed file
types, such as JPG, may
be “lossy,” which means
some of the original bits
may be removed during
compression.

FYI

The ZIP file type is

just one of many for
compressing files and
folders. Other common
file types include 7Z,
RAR, SIT, and TAR.

FYI

Some software can
open a file directly from
within a compressed
file without the need to
extract the file.
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Figure 4-17. Double-clicking on a ZIP file displays its contents in Windows File
Explorer.
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COMPRESSING FILES

It is a common practice to compress multiple files into a single ZIP file in order to e-mail
them. This not only reduces the overall size, it allows the recipient to save a single ZIP file from
the e-mail instead of having to save multiple files.

1.

Launch Windows File Explorer.
Applying what you have learned, search the Windows folder for any file with the .jpg file

extension.

Applying what you have learned, select three or four image files.
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HANDS-ON EXAMPLE 4.4.2 (CONTINUED)

4. Right-click on the selection, and click Send to>Com pressed (zipped) folder in the shortcut menu.
Because Windows cannot create a ZIP file in the search results, a message appears asking if you
would like to create the ZIP file on the desktop. Click the Yes button.

5. Display the Windows desktop. The easiest way to do this is to use the [Alt][Tab] key combination
to navigate through open windows. When the desktop is displayed, release the [Alt] key.

6. Locate the new ZIP file on the desktop. The icon for the file looks like a folder with a zipper on it.
The name of the ZIP file will be the same as the first file you selected in the file list.

7. Double-click the ZIP file to display its contents in Windows File Explorer. Notice that the image
files you selected are contained in the ZIP file.

4.4 | [SECTION REVIEW } ’

e

CHECK YOUR UNDERSTANDING IC3 CERTIFICATION PRACTICE

How is help launched for Windows Explorer? The following question is a sample of the types of
questions presented on the IC3 exam.

&

i

2. What are file properties? 2t ;

3 1. Perform this simulation.
4.

5.

Read-only and hidden are examples of file ; i :
List th to back up vour work Select these files and compress them into a
ol s e ; zipped folder: Paper.docx, Presentation.pptx, and
How do you compress a group of files selected in
i Results.xlsx.

Windows Explorer?
P BUILD YOUR VOCABULARY
As you progress through this course, develop a
personal IT glossary. This will help you build your
vocabulary and prepare you for a career. Write a
definition for each of the following terms and add it to

your IT glossary.

backup file properties
extracting help .
file attribute system image

file compression
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Chapter Summary

Section 4.1
File and Folder Names

e The file name is a label that identifies

a unique file on a computer system. A
folder is a container in which files are
stored.

Windows File Explorer is a file-
management utility with a graphical
user interface that can be used to find

anything in the computer’s storage areas.

The list of available drives and folders
shown in the navigation pane is a file
tree.

Section 4.2
Locating Files and Folders

¢ Good file management involves

organizing files in logical locations. The
ability to locate files is a key skill in good
computer use.

Files and folders can be arranged by a
certain criterion, such as alphabetically,
by date, or by size. This can help locate a
file or folder.

Section 4.3
Organizing Files and Folders

e Files and folders can be easily copied

or moved about any storage drive or
between devices. The source is the
original location, while the destination is
the new location.

Deleting files and folders is an important
part of good file management. A deleted
file or folder can be restored if needed.

Section 4.4
File Utilities

® Help is a resource to assist the user in

learning how to use a feature of the
program. Help is provided by almost

Unit 1 Computing Fundamentals

REVIEW AND ASSESSMENT |

all software programs, including the
Windows operating system.

® The file properties are all information
about the file, but not the data contained
within the file. The file properties are
displayed in the Properties dialog box.

® Abackup is a copy of a file that can be
safely retrieved if anything unfortunate
happens to the most recent version of
the file. A backup can be created on a
different device or versions of the file can
be created.

* File compression is a process of
compacting the data in a file or group
of files to reduce the overall size. File
compression can be done to save disk
space or to reduce the file size for e-mail
transmission.

Now that you have finished
this chapter, see what you
know about information
technology by scanning
the QR code to take the
chapter posttest. If you do
not have a smartphone,
visit www.g-wlearning.com.

Chapter 4 Test

Multiple Choice

Select the best response.

1. Using capital letters to show where new
words start in a file name is called .
A, CamelCase
B. title case
C. uppercase
D. lowercase
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2. Which of the following is not a good
file-management practice?

A. Create descriptive-names for folders
and files.

B. Store all of the data files at the top
level of the drive to make them
easier to find.

C. Remove folders and files when they
are no longer needed.

D. Make enough subfolders so that the
files in any one folder are readily
visible.

3. What are used in the search box to rep-
resent unknown characters?

A. digits

B. characters

C. blanks

D. wildcards

4. Which key combination is used to copy

a file?

A. [CHl][X]

B. [Ctr][C]

C. [Ctri][V]

D. [Ctr][Z]

5. Where are deleted files and folders
stored in Windows?

A. In the recycle bin.

B. In the root folder of the drive.

C. In the original folder.

D. They are not retained.

Completion
Complete the following sentences with the
correct word(s).
6. The three parts of a file path in Win-
dows arethe .

7. A(n) is a pattern that is followed
whenever a file name is created.

8. The asterisk (*) and question mark (?)
are ____ to use in names when search-
ing for files or folders.
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9,

10.

REVIEW AND ASSESSMENT

is a procedure in which an item is
selected in one location, moved with the
mouse, and placed in another location.
File properties are displayed inthe
dialog box.

Matching

Match the correct term with its definition.

13.
14.
15.

Subfolder

Rename

Sort

Copy

Backup

Make copies of files in case of loss.

Put a file in a new location while keep-
ing the original file in its place.

Nested within the parent folder.
Arrange files based on their properties.

Single-click twice on the file or folder in
the file list.

Application and Extension
of Knowledge

1

You and your team must create a dis-
play of these ecosystems: desert, rain-
forest, deciduous forest, tundra, and
marine. The display will include images
of the ecosystems and the animals, trees,
and flowers found in them. There will
also be documents for annual rainfall,
manufacturing, human habitation, and
traffic. Plan a folder structure so that
each team member can locate the proper
place to store relevant files. Create a
naming convention that will make it
clear what each file contains.

. Using the naming convention created

in #1, set up the folder structure. Where
will the project folder be located? Will
each team member have access to this
folder?
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3. Using Windows Explorer, search the
Windows folder and all of its subfolders
for any file with the .jpg file name exten-
sion. How many files are located? Sort
the files by date, from newest to oldest.
Copy the newest file to your flash drive.

4. Display the Properties dialog box for
the image file copied to your flash drive

in #3. What is the size of the file? When
was the file created? Is the file a read-
only file? Display the Details tab in the
dialog box. Examine the information
provided on this tab, and write one para-
graph summarizing what is provided.

5. Write one paragraph that summarizes
what a system image is, how it is cre-
ated, and why it is important to create a
system image.

Online Activities

Complete the following activities, which will
help you learn, practice, and expand your
knowledge and skills.

|Z|* Certification Practice. Complete the
certification practice test for this chapter.

I'_/? Vocabulary. Practice vocabulary for
this chapter using the e-flash cards, matching
activity, and vocabulary game until you are
able to recognize their meanings.

Communication Skills

Speaking. All careers require
that individuals be able to

@ participate and contribute
to one-on-one discussions.
Developing intrapersonal

College communication skills is
and Career e way to achieve career
Readiness

opportunities. As your
instructor lectures on this chapter, contribute
thoughtful comments when participation is
invited.
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Listening. Hearing is a physical process.
Listening combines hearing with evaluation.
Effective leaders learn how to listen to their
team members. Listen to your instructor

as a lesson is presented. Analyze the
effectiveness of the presentation. Listen
carefully and take notes about the main
points. Then organize the key information
that you heard.

Writing. Contributing citizens pay their fair
share of taxes to support the government.
Select two tax laws that generate funds for
government services and analyze how they
work. Write several paragraphs to describe
how the revenue generated from these taxes
help contribute to the betterment of the
community.

Internet Research

IT Careers. Using various Internet resources,
research the current job opportunities and
general qualifications for an IT career that
interests you. Use the career clusters as a
starting point. Write a one-page report about
job prospects that evaluates your findings.
Include data from your research in the
report. Use correct grammar, punctuation,
spelling, and terminology to write and edit
the document.

Teamwork

Work with your team to develop a list of
questions that could be used to gather
information about what electronics are
purchased or used by young adults. Next,
create a focus group for the research.
Appoint a mediator who will ask the
questions and a recorder who will record the
answers. As a team, interpret the results of
the focus group.
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Portfolio Development CTSOs

— Digital File Formats. A portfolio
will contain documents you
@ created electronically as well
as documents that you have in

Teamwork. Some
competitive events for
CTSOs have a teamwork
component. If it is a team

hard copy format that will be
scanned. It will be necessary
to decide file formats to use

event, it is important that the competing
team prepares to operate as a cohesive unit.
To prepare for teamwork activities, complete

College
and Career

Readiness ¢, both types of documents.

Before you begin, consider the technology
that you might use for creating and scanning
documents. You will need access to desktop
publishing software, scanners, cameras, and
other digital equipment or software.

For documents that you create, consider
using the default format to save the files.
For example, you could save letters and
essays created in Microsoft Word in DOCx
format. You could save worksheets created
in Microsoft Excel in XLSx format. If your

presentation will include graphics or video,
confirm the file formats that are necessary
for each item. Use the appropriate formats as
you create the documents.

Hard copy items will need to be converted
to digital format. Portable document format,
or PDE is a good choice for scanned items,
such as awards and certificates.

Another option is to save all documents

as PDF files. Keep in mind that the person
reviewing your digital portfolio will need
programs that open these formats to view
your files. Having all of the files in the same
format can make viewing them easier for
others who need to review your portfolio.

1. Establish the types of technology that
are available for you to create a digital
portfolio. Will you have access to cam-
eras or studios? Do you have the level of
skill needed to create videos?

. Decide the type of presentation you will
use. Research what will be needed to
create the final portfolio product.
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the following activities.

i

Review the rules to confirm whether
questions will be asked or if the team
will need to defend a case or situation.

. Practice performing as a team by com-

pleting the team activities at the end of
each chapter in this text. This will help
members learn how to interact with
each other and participate effectively.

. Locate a rubric or scoring sheet for the

event on your organization’s website to
see how the team will be judged.

. Confirm whether visual aids may be

used in the presentation and the amount
of setup time permitted.

. Make notes on index cards about impor-

tant points to remember. Team members
should exchange note cards so that each
evaluates the other person’s notes. Use
these notes to study. You may also be
able to use these notes during the event.

. Assign each team member a role for

the presentation. Practice performing

as a team. Each team member should
introduce himself or herself, review the
case, make suggestions for the case, and
conclude with a summary:.

. Ask your instructor to play the role of

competition judge as your team re-
views the case. After the presentation
is complete, ask for feedback from your
instructor. You may also consider hav-
ing a student audience listen and give
feedback.
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